草业信息学实验课讲义
（修订版）
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1、 课程概况

课程名称：草业信息学实验
总学时数及课程安排：本实验课共36学时，共3个学分，分9次实验课，每次4学时，本学期6-14周每周四上午上课。
学生专业及人数：草业科学专业20人、草业科学基地班30人、农林经济管理专业39人，共计89人
教学条件：榆中校区可容纳100人的计算机机房（C102）
教学方法：课堂讲授示范和上机练习相结合

2、 课程的性质、目的和任务 
草业信息学是现代信息技术与草业科学相结合的新兴交叉学科，是草业科学的重要分支学科，它运用草原学、生态学和信息学等科学的理论与技术，重点研究现代信息技术及其在草业领域的应用，主要包括草业信息的数字化与可视化表达、处理、分析、集成和应用等。

草业信息学实验课是草业信息学课程的重要组成部分，本课程的实践环节由一系列验证性、设计性、综合性等递进式习作构成，可使学生循序渐进地掌握草业地理信息系统的基本功能，特别是通用的空间分析功能。内容包括空间、属性信息查询，遥感图像处理、专题地图制作、数据输入，地图输出，邻近分析，叠置分析，网络分析，不规则三角网的应用等，涉及矢量、栅格、TIN三种数据模型，最后用综合分析帮助学生加深理解草业信息学的理论和方法。
通过本课程的教学，使学生能够学习并掌握草业信息学的基本方法和操作技能，深入理解草业信息学在草业科学研究领域的作用和角色。熟悉信息学，尤其是地理信息系统方面的技术和方法，以及在草业科学领域的应用。
3、 课程教学的基本要求
通过本课程的学习，要求学生学习掌握草业信息学在草业科学研究领域的应用方法，学习和掌握地理信息系统软件常规操作，帮助学生理解和掌握草业信息学的理论和方法。
4、 教学参考书
1. Kang-tsung Chang著，陈健飞译.地理信息系统导论（第五版）.科学出版社，2010.
2. 汤国安，杨昕 编著 ArcGIS地理信息系统空间分析实验教程科学出版社，2006.
5、 考核和评价方式
采用随堂作业打分和考试相结合的考核方法，安排4次随堂作业，1次随堂考试，其中随堂作业占40%，随堂考试占60%。

6、 实验课程课程教学内容

1.空间、属性信息查询，坐标系统和投影转换操作（4学时）
2.空间数据获取和编辑操作（4学时）
3.矢量数据分析基础操作（4学时）
4.遥感图像处理、专题地图显示输出（4学时）
5.栅格数据空间分析（4学时）
6.地统计分析和空间插值（4学时）
7.草地生物量遥感监测和模拟计算（4学时）
8.草业信息数据库设计和实现（4学时）
9.空间分析建模综合分析（4学时）
第一次实验课讲义
实验内容：空间、属性信息查询，坐标系统和投影转换操作（4学时）
一、熟悉ArcGIS软件界面。
ArcGIS是ESRI公司发布的一套完整的GIS产品系列。包括以下几个产品：

ArcGIS Desktop - 一套集成的、桌面端的专业 GIS 应用程序。

ArcGIS Server -以 Web 服务形式提供 GIS 信息和地图，并且支持企业级数据管理。

ArcGIS Mobile - 为野外计算提供移动 GIS 工具和应用程序。

ArcGIS Desktop是一系列整合的应用程序的总称，包括ArcMap、ArcCatalog、 ArcToolbox 、ArcGlobe、ArcScene和Model Builder。分为三个层次：
ArcGIS Desktop Basic 提供了全面的制图、数据使用、分析以及简单的数据编辑和空间处理工具；
ArcGIS Desktop Standard 提供高级编辑功能；
ArcGIS Desktop Advanced是一个全功能的GIS桌面产品。
ArcMap是ArcGIS Desktop中一个主要的应用程序，承担所有制图和编辑任务，也包括基于地图的查询和分析功能。

ArcCatalog应用程序帮助用户组织和管理所有的GIS信息，比如地图、数据文件、空间处理工具箱、元数据、服务等。

ArcToolbox包括了ArcGIS for Desktop提供的所有空间处理工具。

二、空间、属性信息的查询
ArcGIS软件可以实现空间数据的空间位置和属性信息的查询功能。

1 在ArcMap中打开练习数据。

2 使用Tool工具栏的Identity工具执行查询操作

（1）点击Identity工具按钮。

（2）在地图任意位置点击鼠标，弹出属性信息窗口。

（3）观察点击位置的空间信息（坐标）和属性信息（属性表）。

（4）尝试点击地图的不同位置，观察查询结果的异同。

（5）尝试画线、多边形进行查询操作。

三、定义投影
定义投影（Define Projection），指按照地图信息源原有的投影方式，为数据添加投影信息。具体操作如下： 

1.展开Data Management Tools工具箱，打开Projections and Transformations工具集，双击Define Projection工具，打开Define Projection对话框。 
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2.在Input Dataset or Feature Class文本框中选择输入需要定义投影的数据。
3. Coordinate System文本框显示为Unknown，表明原始数据没有坐标系统。单击Coordinate System文本框旁边的图标，打开Spatial Reference属性对话框设置数据的投影参数。

4. 定义投影有三种方法：

（1）单击Select按钮，打开Browe for Coordinate System对话框，为数据选择坐标系统。其中坐标系统分为地理坐标系统（Geographic Coordinate Systems）和投影坐标系统（Projected Coordinate Systems）两种类型。地理坐标系统是利用地球表面的经纬度表示；投影坐标系统是将三维地球表面上的经纬度经过数学转换为二维平面上的坐标系统，在定义坐标系统之前，要了解数据的来源，以便选择合适的坐标系统。

（2）当已知原始数据与某一数据的投影相同时，可单击图4.4中的Import按钮，浏览确定使用其坐标系统的数据，用该数据的投影信息来定义原始数据，因此两个数据具有相同的投影信息。

（3）单击New按钮，新建一个坐标系统。同样可以新建地理坐标系统和投影坐标系统两种坐标系统。
5. 定义投影后，则回到图4.3 Spatial Reference属性对话框，在Detail下的窗口中可以看到定义投影的详细信息。单击Modify按钮可对已定义的投影进行修改，单击Clear按钮则清除上一步定义的投影，重新定义。

6. 单击OK完成。 

四、投影变换 

回顾理论课关于投影的概念。
投影变换（Project）是将一种地图投影转换为另一种地图投影，主要包括投影类型、投影参数或椭球体等的改变。
在ArcToolbox的Data Management Tools- Projections and Transformations工具集中分为栅格和要素类两种类型的投影变换，其中在对栅格数据进行投影变换时，要进行重采样。
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（1） 展开Data Management Tools工具箱，打开 Projections and Transformations中的Raster工具集，双击Project Raster，打开Project Raster对话框（图4.8）。
（2） 在Input raster文本框中选择输入进行投影变换的栅格数据。

（3） 在Output raster文本框键入输出的栅格数据的路径与名称。

（4） 单击Output coordinate system文本框旁边的图标，打开Spatial Reference属性对话框，定义输出数据的投影。
（5）选择栅格数据在新的投影类型下的重采样方式，默认状态是NEAREST，即最临近采样法。还可以直接设定栅格的大小，或浏览确定某一栅格数据，输出数据的栅格大小则与该数据相同。 
（6）单击OK按钮，执行。

五、课堂练习

1 在中国地图上查询家乡的坐标和名称信息。

2 对中国地图进行转投影操作，观察不同投影下的地图形状的差异。

六、本次实验课的难点和可能存在的问题
1 学生对英文界面软件的适应情况

2 学生对空间信息的认知

3 学生对地图投影的理解

第二次实验课讲义

实验内容：空间数据获取和编辑操作（4学时）

一、回顾上次实验的主要内容
1 地图投影的概念和具体操作步骤。

2 回顾理论课关于空间数据获取的相关知识
二、创建新Shapefile和dBASE表
ArcCatalog可以创建新的shapefile和dBASE表，并通过添加、删除和索引属性来修改它们，也可以定义shapefile的坐标系统和更新其空间索引。当在ArcCatalog中改变shapefile的结构和特性（properties）时，必须使用ArcMap来修改其要素和属性。

1 创建新的Shapefile

当创建一个新的shapefile时，必须定义它将包含的要素类型，Shapefile 创建之后，这个类型不能被修改。如果选择了以后定义shapefile的坐标系统，那么直到被定义前，它将被定义为“Unkown”。

创建一个新的shapefile文件的具体过程如下：

[image: image7.emf]（1） 在ArcCatalog目录树中，右键单击需要创建Shapefile的文件夹，单击New，再单击Shapefile，如下图所示。

（2） 打开Create New Shapefile对话框，设置文件名称和要素类型。要素类型可以通过下拉菜单选择Polyline、 Polygon、 MultiPoint、 MultiPatch等要素类型。
（3） 单击Edit按钮，定义Shapefile的坐标系统，打开Spatial Reference对话框，如图3.3所示。

（4） 单击Select按钮，可以选择一种预定义的坐标系统；单击Import按钮，可以选择想要复制其坐标系统的数据源；单击New按钮，可以定义一个新的、自定义的坐标系统（具体介绍见第四章）。

（5） 如果Shapefile要存储表示路线的折线，那么要复选Coordinates will contain M Values，如果Shapefile将存储三维要素，那么要复选Coordinates will contain Z Values。

（6） 单击OK按钮，新的Shapefile在文件夹中出现。

2 创建新的dBASE表

在Catalog目录数中，右键单击需要创建dBASE表的文件夹，单击New，再单击dBASE表，为其输入一个名称，并按回车键。

三 空间数据编辑

数据编辑是纠正数据错误的重要手段，主要包括几何数据和属性数据的编辑。几何数据的编辑主要是针对图形的操作，包括平行线复制、缓冲区生成、镜面反射、图层合并、结点操作、拓扑编辑等。属性数据的编辑包括对图形要素的属性进行添加、删除、修改、复制等。
1 空间数据基本编辑
在ArcMap中对所加载的数据的图形要素可以进行各种编辑，如平行线复制、缓冲区生成、镜面反射、拼接处理、结点删除、结点添加、线的延长和裁剪、形的分割等。

线与多边以下操作都是以打开地图文档，并开始编辑（Start Editing）数据层为前提。
1） 要素复制操作
单击按钮，在图形窗口中选择要复制的线要素，单击Target箭头，选择需要复制平行线的数据层，在Editor下拉菜单中，选择Copy Parallel命令，打开Distance对话框。输入平行线之间的距离（按照地图单位），输入的距离数值的正负值表示要素的复制方向。按Enter键即可完成操作。

2） 要素合并
ArcMap系统的要素合并操作可以概括为两种类型，要素空间合并与要素裁剪合并。要素空间合并包括Merge和Union两个基本操作。要素裁剪合并可以在同一个数据层中进行，也可在不同数据层之间进行，参与合并的要素可以是相邻要素，也可以是分离要素，当然，只有相同类型的要素才可以合并。
Merge --只能是同层要素（重叠或分离）合并，新要素生成，同时原来的要素自动删除。

Union --同层或异层的要素（重叠或分离）合并，合并后产生新要素，原要素不删除。

3）要素分割
点进行分割，也可以在离开线的起点或终点一定的距离处分割，还可以按照线要素长度百分比进行分割，分割后线要素的属性值是分割前线要素属性值的复制。对于多边形要素，是按照所绘制的分割线进行分割，多边形原有的属性将复制到分割以后的多边形要素当中。
Split - -按长度或百分比分割，分割后原要素删除

Divide - -布点分割，可以删除或者保留原要素多边形：
2地图属性信息的编辑
属性表的编辑操作有两种方式：

1）右击需要编辑属性的要素，选择Attributes，左边显示被选中的要素，右边显示属性字段及属性值。单击Value，可修改其属性值。
2）击需要进行属性编辑的图层，Open Attribute Table打开属性表，可添加字段、修改字段值、关联表、属性表导出等操作。
四、课堂练习

1 尝试使用不同的工具编辑地图要素。

2 练习使用Merge、Union、Split、Divide等工具编辑地图。

第三次实验课讲义

实验内容：矢量数据分析基础操作（4学时）
一、回顾上次实验的主要内容

1 地图编辑的具体操作步骤。

2 回顾理论课关于矢量数据分析的相关知识

二、ArcGIS叠置分析

叠置分析是地理信息系统中用来提取空间隐含信息的方法之一。

叠置分析是将代表不同主题的各个数据层面进行叠置产生一个新的数据层面，叠置结果综合了原来两个或多个层面要素所具有的属性。叠置分析不仅生成了新的空间关系，而且还将输入的多个数据层的属性联系起来产生了新的属性关系。
叠置分析要求被叠加的要素层面必须是基于相同坐标系统的相同区域，同时还必须查验叠加层面之间的基准面是否相同。

从原理上说，叠置分析是对新要素的属性按一定的数学模型进行计算分析，其中往往涉及到逻辑交、逻辑并、逻辑差等运算。

叠置分析要求被叠加的要素层面必须是基于相同坐标系统的相同区域，同时还必须查验叠加层面之间的基准面是否相同。

从原理上说，叠置分析是对新要素的属性按一定的数学模型进行计算分析，其中往往涉及到逻辑交、逻辑并、逻辑差等运算。
1图层擦除（Erase）
图层擦除是指根据参照图层的范围大小，擦除参照图层所覆盖的输入图层内的要素。在ArcGIS中实现图层擦除的操作，步骤如下：

1）打开ArcMap，打开ArcToolbox工具箱，选择Analysis Tools|Overlay|Erase工具，打开Erase对话框。

2）在Erase操作对话框中选择输入图层，擦除参照，输出图层。

3）单击ok按钮，完成操作。
2识别（Identity）
输入图层进行识别叠加，是在图形交叠的区域，识别图层的属性将赋给输入图层在该区域内的地图要素，同时也有部分的图形变化在其中。在ArcGIS中的具体操作：

1）在ArcToolbox中，选择Analysis Tools|Overlay|Identity工具，打开Identity对话框。

2）分别设置输入图层（Input features），识别参照图层（Identity features），输出图层（Output Feature Class）和选择需要连接的属性字段（Join Attributes）。

3交集操作（Intersect）
交集操作是通过叠置处理得到两个图层的交集部分，并且原图层的所有属性将同时在新的图层上显示出来。在ArcGIS中的具体操作：

1）在ArcToolbox中，选择Analysis Tools|Overlay|Intersect工具，打开Intersect对话框。

2）逐个输入要进行相交的图层，设置输出文件的路径和名称，选择要进行连接的属性字段，确定输出文件类型。

4 对称区别（Symmetrical Difference）
在矢量的叠置分析中有时只需获得两个图层叠加后去掉其公共的区域。新生成的图层的属性也是综合两者的属性而产生的。
5图层合并（Union）
图层合并是指通过把两个图层的区域范围联合起来而保持来自输入地图和叠加地图的所有地图要素。在布尔运算上用的是“or”关键字。

在图层合并时要求两个图层的几何特性全部是多边形。
三、ArcGIS缓冲区分析

缓冲区（Buffer）：是对一组或一类地图要素（点、线或面）按设定的距离条件，围绕这组要素而形成具有一定范围的多边形实体，从而实现数据在二维空间扩展的信息分析方法。
从数学的角度看，缓冲区是给定空间对象或集合后获得的它们的邻域。邻域的大小由邻域的半径或缓冲区建立条件来决定。因此对于一个给定的对象A。

ArcGIS中建立缓冲区的方法是基于生成多边形（buffer wizard）来实现的。它根据给定的缓冲区距离，对点状、线状和面状要素的周围形成缓冲区多边形图层，是矢量结构。操作步骤：

1）在ArcMap中加载点数据。

2）加载缓冲区工具：选择Tools菜单下的Customize命令，进入Command标签。
3）点击图标，出现Buffer Wizard对话框。
4) 使用向导完成缓冲区建立
四、地统计学分析初步

地统计（Geostatistics）又称地质统计，是在法国著名统计学家G. Matheron大量理论研究的基础上逐渐形成的一门新的统计学分支。它是以区域化变量为基础，借助变异函数，研究既具有随机性又具有结构性，或空间相关性和依赖性的自然现象的一门科学。简单介绍ArcGIS Geostatistical Analyst提供的插值方法：

1 泰森多边形

2 趋势面

3样条函数

4 反距离加权

5 克里金

五、课堂练习

1 练习叠置分析和缓冲区分析的操作。

2 熟悉和了解空间插值的操作。

第四次实验课讲义

实验内容：遥感图像处理、专题地图显示输出（4学时）
一、回顾上次实验的主要内容

1 空间叠置和缓冲区分析的具体操作步骤。

2 回顾理论课关于遥感数据分析的相关知识

二、遥感卫星影像的显示
1 TM 432假彩色合成操作步骤：

1）加载TM影像

2）点击图层属性，选择渲染方式

3）调整RGB显示顺序和波段

4）确定

2 遥感图像图像拼接操作步骤

1）打开需要拼接的卫星影像

2）打开mosaic to new raster 工具

3）将需要拼接的影像加载进去，设置参数

4）点OK完成。

三、专题图的制作

1、地图模板操作

ArcMap不仅为用户编制地图提供丰富的功能和途径，并且从实际应用出发，将常用的地图输出样式制作成地图模板（Map Template），用户可以直接调用，减少了很多常规设置。当然，也可以根据工作需要定制自己的地图模板。
2、图面尺寸设置：

ArcMap窗口包括数据视图（Data view）和版面视图（Layout view），在正式输出地图之前，应在版面视图里，按照比例尺、用途以及打印机型号等等来设置版面尺寸。若没有设置，采用系统默认设置。
3、图框与底色设置 
ArcMap地图文档是由一个或多个数据组构成的，相应的，ArcMap的输出地图可以是一个或多个数据组构成，每个数据组可以设置不同的图框和底色。
4、绘制坐标格网

地图中的坐标格网是地图的三大要素之一，反映地图的坐标系统或地图投影信息。不同制图区域的大小，有不同类型的坐标格网：小比例尺大区域的地图通常使用经纬线格网；中比例尺中区域地图通常使用投影坐标网格；大比例尺小区域地图，通常采用公里格网或索引参考格网。

在需要放置地理坐标网格的数据组上右击，弹出快捷菜单，单击Properties…命令按钮打开Data FrameProperties对话框。单击Grids选项卡。
单击New Grid 按钮，打开Grids and Graticules Wizard对话框。

选择Graticule:divides map by meridians and parallels(绘制经纬线格网）单选按钮。

单击Finish按钮，完成经维网的设置。返回Data Frame Properties对话框。
5、所谓地图整饰，就是地图表现形式，表示方法和地图图型的总称。包括地图色彩与地图符号设计、线划和注记的刻绘、地形图的立体表现、图面配置与图外装饰设计、地图集的图幅编排和装帧。
整饰的目的是：达到地图形式同内容的统一；实现地图科学性与艺术性的结合；降低地图生产成本。

6、图名的放置与修改的步骤：

在ArcMap菜单栏上单击View→Layout View选项，打开版面视图。

单击Insert→Title选项，出现Enter Map Title矩形框。

在此框中输入图名。拖动矩形框，改变其位置
7、图例的放置与修改
图例说明了地图内容的确切含义。包括两个部分，一部分是用于表示地图符号的点线面按钮；另一部分是对地图符号含义的标注与说明。

单击Insert→Legend选项，打开Legend Wizard对话框
设置图例标题等内容

预览图例效果
拖动图例至合适的部分，如果对图例效果不满意，可以右击图例，打开属性对话框进行设置
8、比例尺的放置与修改

地图上标注的比例尺有数字比例尺和图形比例尺两种。数字比例尺精确地表达地图要素与所代表地物之间的定量关系，但不够直观，而且随着地图的变形与缩放，数字比例尺标注的数字无法相应变化；无法直接用于地图的测量。图形比例尺虽然不能精确的表达制图比例，但可以用于地图测量，而且随地图本身的变形与缩放一起变化。
单击Insert→Scale Bar…选项，打开Scale Bar Selector对话框
选择比例尺样式
设置所选比例尺属性
拖动放置比例尺位置

9、指北针的放置
单击Insert→North Arrow 选项，打开 North Arrow窗口
选择指北针样式
对所选指北针进行属性编辑
10、地图输出

选择file下的export map按钮

设置输出参数

点击OK完成地图输出

四、课堂练习及作业
1 练习制作专题地图。

2 提交一份JPG格式的专题地图。

第五次实验课讲义

实验内容：.栅格数据空间分析（4学时）

一、回顾上次实验的主要内容

1 遥感数据的具体操作步骤。

2 回顾理论课关于栅格数据空间分析的相关知识

二、栅格数据空间分析环境设置
ArcGIS中提供了Spatial Analyst模块用于分析栅格数据。要使用该模块，应先加载：单击Tools菜单下的Extensions，选择Spatial Analyst，单击Close完成加载。在ArcMap菜单区单击鼠标右键，选择Spatial Analyst工具，就可将其加载到视图中。
可在Spatial Analyst下拉菜单里的Option中对Spatial Analyst的工作环境进行设置。

包括：工作路径（General->Working）、分析单元格大小（Cell Size->Cell Size）、分析区域（Extent->Analysis extent）、坐标系统（General->Analysis Coordinate System）、过程文件管理（鼠标右键单击文件->Make Permanent）等。
三、格网数据的表面分析
1栅格数据的重采样
工具：Toolbox->Data Management Tools->Raster-> resample
1）
最邻近采样：用输入栅格数据中最邻近栅格值作为输出值。因此，在重采样后的输出栅格中的每个栅格值，都是输入栅格数据中真实存在而未加任何改变的值。

2）
双线形采样，取内插点（x,y）点周围四个邻点，在y方向（或x方向）内插一次，再在x方向（y方向)内插一次，得到（x,y）点的栅格值。

3）
三次卷积采样，这是进一步提高内插精度的一种方法。它的基本思想是增加邻点来获得最佳插值函数。取内插点周围相邻的 16个样点数据，与双线形采样类似，分方向内插。
2等值线绘制
等直线是将表面上相邻的具有相同值的点连接起来的线。
操作步骤：

1）选择Spatial Analyst->Spatial Analysis->Contour

2）Input surface中选择用来生成等直线的栅格数据集，

3）在Contour interval 中设置等值距，

4）Base contour 中设置基准值。

5）Z factor 设置变换系数。

6）Output raster 中输入输出结果名称。
7）点OK键完成。
3地形因子提取
坡度：地表任意一点的坡度是指过这点的切平面与水平地面的夹角，坡度表示了地表面在该点的倾斜程度。
操作步骤：
1）选择Spatial Analyst->Spatial Analysis->Slope

2）Input surface中选择栅格数据集，

3）Output measurement 中选择坡度表示方式，

4）Z factor 设置变换系数。

5）Output cell size 设置输出栅格大小，

6）Output raster 中输入输出结果名称。

7）点OK键完成。
坡向指地表面上一点的切平面的法线矢量在水平面的投影与过该点的正北方向的夹角。对地面任意一点，坡向表征了该点高程值改变量的最大变化方向。
操作步骤：

1）选择Spatial Analyst->Spatial Analysis->Aspect

2）Input surface中选择栅格数据集， 

3）Output cell size 设置输出栅格大小，

4）Output raster 中输入输出结果名称。

5）点OK键完成。
山体阴影是根据假想的照明光源对高程栅格图的每个栅格单元计算照明值。
操作步骤：

1）选择Spatial Analyst->Spatial Analysis->Hillshade

2）Input surface中选择栅格数据， 

3）在Azimuth中设置太阳方位角，

4）在Altitude中设置太阳高度角。

5）Model shadows 选中，则落在阴影内的单元赋值为0。

6）在Z factor 中设定高程变换系数。

7）在Output cell size 中设定输出栅格单元大小。

8）Output raster 中输入输出结果名称。

9）点OK键完成。
三 统计分析
1 单元统计
ArcGIS中提供十种单元统计方法：
1）Minimum：单元值中的最小数值。

2)Maximum：单元值中的最大数值。

3）Range：单元值的数值范围。

4）Sum：单元值的总和。

5）Mean：单元值的平均值。

6）StandardDeviation：单元值的标准差。

7）Variety：单元值中不同数值的个数。

8）Majority：单元值中出现频率最高的数值。

9）Minority：单元值中出现频率最低的数据。

10）Median：单元值中的中央值。
操作步骤：

1）选择Spatial Analyst->Cell Statistics

2）Layers中选择栅格数据，单击Add按钮将其加入Input列表，或通过Browse按钮选择硬盘中数据。 

3）在Overlay statistic中选择统计类型，

4）Output raster 中输入输出结果名称。

5）点OK键完成。
2 邻域统计
邻域统计是以待计算栅格为中心，通过计算其周围一定范围内栅格数据的统计值，来确定该栅格值的过程。
操作步骤：

1）选择Spatial Analyst->Neighborhood Statistics

2）Input data中选择栅格数据， 

3）在Field中选择邻域分析字段，

4）在Statistics中选择统计类型。

5）Neighborhood中选择邻域分析窗口类型，设定参数。

6）在Units中选择邻域分析窗口单位（栅格、地图）。

7）在Output cell size 中设定输出栅格单元大小。

8）Output raster 中输入输出结果名称。

9）点OK键完成。
3分类区统计
分类区统计，即以一个数据集的分类区为基础，对另一个数据集进行数据统计分析，包括计算数值取值范围、最大值、最小值、标准差等。一个分类区就是在栅格数据中拥有相同值的所有栅格单元，而不考虑他们是否邻近。分类区统计是在每一个分类区的基础上运行操作，所以输出结果时同一分类区被赋予相同的单一输出值。
操作步骤：

1）选择Spatial Analyst->Zonal Statistics

2）在Zone dataset中选择分类区数据层， 

3）在Zone field中选择邻域分析字段，

4）在Value raster中选择统计数据。

5）Ignore NoData in calculations,可选项，是否允许栅格数据中的空值参与运算。。

6）Join output table to zone layer。可选项，是否将统计结果表连接到分类区数据层。

7）在Chart statistic中选择统计类型。

8）Output table 中输入输出结果的目录和名称。

9）点OK键完成。
4 重分类操作步骤：

1）选择Spatial Analyst->Reclassify

2）Input Raster中选择要重新组合分类的栅格数据， 

3）在Reclass Field中选择需用的字段，

4）单击Classify，打开Classification 对话框。

5）在Method下拉菜单中选择一种分类方法：包括Manual（手工分类）、Equal Interval（等间距分类）、Defined Interval（自定义间距分类）、Quantile（分位数分类）、Natural Breaks（自然间距分类）、Standard Deviation（标准差分类）。

6）单击Classification 对话框的OK 按钮。

7）在Reclassify 对话框中New values列表框中输入新的分类数值，或通过Load导入已有重映射表。

8）可通过Save 按钮保存当前重映射表。

9）Output raster 中输入输出结果名称。

10）点OK键完成。
五、课堂练习

1 练习栅格数据分析的常规操作，如坡度、坡向提取、重采样、重分类。

第六次实验课讲义

实验内容：地统计分析和空间插值（4学时）
一、回顾上次实验的主要内容

1 栅格数据空间分析具体操作步骤。

2 回顾理论课关于空间插值的相关知识

二、栅格插值

栅格插值就是通过一定数量的已知点值来推算未知点值的过程。
1）反距离权重插值（Inverse Distance Weighted， IDW）
反距离加权法是最常用的空间内插方法之一。它认为与未采样点距离最近的若干个点对未采样点值的贡献最大，其贡献与距离成反比。
反距离权重插值的特点：该插值方法假设已知点的分布均匀，未知点的值和已知点的值存在距离上的连续性和相关性。即，该研究数据或地理特性分布只与空间位置（距离）相关，插值精度依赖已知点的分布是否均匀或是否能反映被插值的分布特点。
操作步骤：

1、单击Spatial Analyst下拉菜单，单击选中Interpolate to Raster，在弹出的下下一级菜单中单击Inverse Distance Weighted命令，打开IDW对话框。

2、单击Input points下拉菜单，选择参加内插计算的点数据集。

3、单击Z Value field 下拉菜单，选择参加内插计算的字段名称。

4、在Power文本框中输入IDW的幂值。

5、单击Search radius type下拉菜单，选择搜索半径类型。

A、Variable: 可变搜索半径。

B、Fixed: 固定搜索半径。

6、Use barriers polylines : 用于指定一个中断线文件。

7、Output cell size: 输出结果的栅格大小。

8、Output raster：输出结果文件名。

9、单击OK完成操作。
2）样条函数插值（SPLINE）
样条插值的目标就是寻找一表面s(t)，使它满足最优平滑原则，也就是说，利用样本点拟合光滑曲线，使其表面曲率最小。

相当于扭曲一个橡皮，使它通过所有样点，同时曲率最小。

样条函数是灵活曲线规的数学等式，为分段函数，一次拟合只有少数数据点配准，同时保证曲线段的连接处为平滑连续曲线。这就意味着样条函数可以修改曲线的某一段而不必重新计算整条曲线，插值速度快；保留了微地物特征，视觉上的满意效果。
样条函数每次只用少量的数据点，被插值速度快。样条函数易操作，计算量不大，它与空间统计方法相比具有以下特点：不需要对空间方差的结构做预先估计；不需要做统计假设，而这些假设往往是难以估计和验证的；同时，当表面很平滑时，也不牺牲精度。样条函数适合于非常平滑的表面，一般要求有连续的一阶和二阶导数；它适合于根据很密的点内插等值线，特别是从不规则三角网（TIN）内插等值线。

缺点：样条内插的误差不能直接估算。点稀时效果不好。
操作步骤：

1）选择Spatial Analyst->Interpolate to Raster->Spline

2）Input point中选择所要插值的点数据，

3）Z value field 中选择所要插值的字段，

4）Spline type 中选择样条插值方法：Regularized（规则样条）、Tension（张力样条）。

5）Weight 中输入权重。

6）Number of points 中输入参加运算的样本点数。

7）Output cell size 
中输入所输出栅格大小。

8）Output raster 中输入输出结果名称。

9）点OK键完成。
3）克里金插值（Kriging）

克里金插值：认为任何在空间连续性变化的属性是非常不规则的，不能用简单平滑数学函数进行模拟，可以用随机表面给予较恰当的描述。

目的：提供确定权重系数最优的方法和并能描述误差信息

理论假设：任何变量的空间变化表现为三个主要成分的和：A.与恒定均值或趋势有关的结构性成分；B.与空间变化有关的随机变量，即区域性变量；C.与空间无关的随机噪声项或剩余误差项。即差异的稳定性和可变性，一旦结构性成分确定后，剩余的差异变化属于同质变化，不同位置之间的差异仅是距离的函数。克里金法的优点是以空间统计学作为其坚实的理论基础，物理含义明确；不但能估计测定参数的空间变异分布，而且还可以估算估计参数的方差分布。克里金法的缺点是计算步骤较烦琐，计算量大，且变异函数有时需要根据经验人为选定。
ordinary kriging是单个变量的局部线形最优无偏估计方法，也是最稳健常用的一种方法。 

universal kriging是把一个确定性趋势模型加入到克立金估值中，将空间过程总可以分解为趋势项和残差项两个部分的和，有其合理的一面。如果能够很容易地预测残差的变异函数，那么该方法将会得到非常广泛的应用。
操作步骤：

1）选择Spatial Analyst->Interpolate to Raster->Kriging

2）Input point中选择所要插值的离散点数据，

3）Z value field 中选择所要插值的字段，

4）Kriging  method中选择克里格方法：Ordinary（普通克里格）、Universal（泛克里格）。

5）Semivariogram model 下拉菜单中选择合适的变异函数模型。

6）Search radius type 中选择搜索半径。

7） Output cell size 中输入所输出栅格大小。

8）Create variance of prediction 选择是否需要生成预测的标准误。

9）Output raster 中输入输出结果名称。

10）点OK键完成。

第七次实验课讲义

实验目的：草地生物量遥感监测和模拟计算（4学时）

一、草地生物量遥感监测和模拟计算的一般步骤：

以具体研究工作为例，讲解基于遥感技术的草地生物量监测和模拟计算方法。

1、研究区确定
研究草地生物量首先要确定研究区域，制作研究区示意图。

[image: image8.emf]
图1 青藏高原地形与草地调查样点分布图

2、获取实测数据

地面实测资料一般来自草本样方数据。定位监测样地选在群落的典型地段，面积不小于100 ha，设置1个描述样方和2-4个测产样方，样方大小1m×1m。路线监测选取具有代表性的路线，在相邻草原类型的过渡区域和草原类型的中心区域布点，每个取样点设置描述样方1个，1m×1m测产样方3个。
表1 不同草地类型的调查样本数据基本情况
	类名称
	N
	鲜重(kg/ha)
	
	风干重(kg/ha)
	
	盖度(%)

	
	
	最小值
	最大值
	均值
	方差
	
	最小值
	最大值
	平均值
	方差
	
	最小值
	最大值
	平均值
	方差

	温性草原类
	132
	560.80 
	5010.00 
	2234.51 
	1018.18 
	
	210.00 
	1829.00 
	825.52 
	370.12 
	
	8.00 
	95.00 
	62.70 
	21.93 

	温性荒漠草原类
	34
	250.00 
	2240.00 
	1343.96 
	486.51 
	
	113.00 
	960.00 
	593.80 
	218.78 
	
	4.00 
	80.00 
	46.74 
	20.29 

	高寒草甸草原类
	3
	1404.00 
	1528.00 
	1453.33 
	65.77 
	
	468.00 
	509.00 
	484.33 
	21.73 
	
	10.00 
	15.00 
	13.33 
	2.89 

	高寒草原类
	276
	140.00 
	5583.30 
	1589.01 
	1056.13 
	
	50.00 
	1585.30 
	567.89 
	364.59 
	
	5.00 
	100.00 
	53.16 
	25.65 

	高寒荒漠草原类
	26
	520.00 
	2068.00 
	1309.31 
	311.31 
	
	189.00 
	546.00 
	413.50 
	76.02 
	
	10.00 
	85.00 
	34.15 
	19.12 

	温性草原化荒漠类
	9
	680.00 
	1360.00 
	915.56 
	224.00 
	
	280.00 
	560.00 
	404.44 
	98.88 
	
	28.00 
	60.00 
	42.00 
	11.22 

	温性荒漠类
	38
	276.00 
	3466.70 
	1465.69 
	920.40 
	
	97.00 
	866.00 
	416.55 
	222.95 
	
	2.50 
	83.00 
	29.17 
	19.68 

	高寒荒漠类
	35
	510.00 
	1700.00 
	984.01 
	277.09 
	
	140.07 
	500.00 
	298.86 
	88.94 
	
	15.00 
	99.00 
	53.11 
	17.33 

	暖性灌草丛类
	24
	1370.00 
	5724.00 
	2602.95 
	1117.51 
	
	179.30 
	2927.00 
	1154.63 
	910.53 
	
	10.00 
	95.00 
	62.71 
	30.57 

	热性灌草丛类
	16
	1440.00 
	6420.00 
	3700.38 
	1610.37 
	
	447.00 
	1990.00 
	1147.88 
	500.27 
	
	43.00 
	85.00 
	64.00 
	11.57 

	低地草甸类
	99
	270.00 
	5834.00 
	1947.61 
	1482.50 
	
	104.17 
	2224.30 
	766.78 
	587.83 
	
	5.00 
	100.00 
	47.95 
	29.06 

	山地草甸类
	333
	950.00 
	16508.25 
	6183.17 
	3744.04 
	
	600.00 
	3960.19 
	1789.81 
	924.45 
	
	26.00 
	100.00 
	82.91 
	15.00 

	高寒草甸类
	941
	833.00 
	17875.00 
	5031.51 
	2998.48 
	
	600.00 
	3809.80 
	1621.76 
	728.89 
	
	15.00 
	100.00 
	82.42 
	15.42 

	沼泽类
	4
	2371.50 
	3998.50 
	3185.00 
	939.35 
	
	1115.00 
	1915.00 
	1515.00 
	461.88 
	
	48.00 
	65.00 
	56.50 
	9.81 

	汇总
	1970
	140.00 
	17875.00 
	4079.63 
	3189.73 
	
	50.00 
	3960.19 
	1308.71 
	841.48 
	
	2.50 
	100.00 
	71.81 
	24.37 


3、获取植被指数遥感数据

植被指数数据来自NASA MODIS陆地产品组开发的Terra卫星的月植被指数产品MOD13A3。该产品包含MODIS地面分辨率为1 km的EVI和NDVI月最大合成数据。本研究使用了覆盖青藏高原的空间位置在全球正弦投影系统中编号为h23v04、h23v05、h24v04、h24v05、h24v06、h25v04、h25v05、h25v06、h26v04、h26v05、h26v06、h27v05和h27v06的每月有13景的数字图像，数据格式为EOS-HDF，时间序列为2001-2009年1-12月、2010年1-10月。
4、生物量反演模型建立及精度评价

模型的评价使用留一法交叉验证的方法。首先从观测数据集中选择一个观测数据作为验证数据，然后使用剩下的观测数据反演一个回归模型，并用最先被排除的那个观测值来验证这个模型的精度，如此重复1790次（样本个数）。每个模型的预测能力由RMSEP(Root-Mean-Square Error of Prediction)和观测值与模型预测结果之间的相关系数 r来衡量。两者都常用来描述模型的不确定性。RMSEP常被用来量化模型精度,而r常被用来评估模型的准确性[31]。RMSEP的计算公式如下：
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式中， 表示第i个实际观测值， 为模型反演出的第i个预测值，n是观测样本总数，RMSEP数值越低，表明回归模型更精确。相关系数r越接近于1，表示模型精度越高。
5、模拟结果分析
为了研究青藏高原2001-2010年间草地地上生物量动态变化趋势，利用已建立的青藏高原草地生物量反演模型和MODIS 植被指数产品，结合草地类型图，主要分析研究：1）青藏高原2001-2010年期间的年平均最大草地地上生物量干重分布图；2）青藏高原2001-2010年期间的年平均草地地上生物量干重分布图（2001-2009年使用1-12月月均值，2010年使用1-10月月均值）；3）统计分析青藏高原2001-2010年不同草地类型地上生物量干重月变化和年变化动态。
6、结果展示

1）生物量反演模型

表2 草地鲜重、风干重和盖度模型精度评价

	
	
	鲜重（kg/ha）
	
	风干重(kg DW/ha)
	
	盖度(%)

	指数
	模型
	R2
	RMSEP
	r
	
	R2
	RMSEP
	r
	
	R2
	RMSEP
	r

	evi
	线性
	0.36 
	2567.07 
	0.60 
	
	0.36 
	683.29 
	0.60 
	
	0.42 
	18.63 
	0.65 

	
	指数
	0.49 
	2590.77 
	0.61 
	
	0.46 
	687.92 
	0.59 
	
	0.38 
	19.51 
	0.61 

	
	对数
	0.29 
	2832.64 
	0.54 
	
	0.32 
	734.83 
	0.57 
	
	0.46 
	19.82 
	0.68 

	
	乘幂
	0.48 
	3131.36 
	0.60 
	
	0.47 
	815.63 
	0.60 
	
	0.46 
	23.47 
	0.67 

	ndvi
	线性
	0.34 
	2670.10 
	0.58 
	
	0.37 
	678.94 
	0.61 
	
	0.47 
	17.70 
	0.69 

	
	指数
	0.51 
	2595.21 
	0.61 
	
	0.49 
	671.80 
	0.62 
	
	0.44 
	19.06 
	0.67 

	
	对数
	0.27 
	2747.15 
	0.52 
	
	0.31 
	717.33 
	0.56 
	
	0.48 
	17.82 
	0.69 

	
	乘幂
	0.47 
	2715.93 
	0.58 
	
	0.47 
	693.68 
	0.60 
	
	0.49 
	17.54 
	0.70 


表3 基于NDVI的鲜重、风干重和盖度最优模型的估计参数
	指标
	模型
	参数估计与检验
	
	回归显著性检验

	
	
	参数
	估计值
	T
	
	R2
	F

	鲜重
	指数
	b
	2.653
	45.676*
	
	0.515
	2086.25*

	
	
	a
	684.377
	28.631*
	
	
	

	风干重
	指数
	b
	2.398
	43.623*
	
	0.492
	1902.96*

	
	
	a
	268.810
	30.252*
	
	
	

	盖度
	乘幂
	b
	0.599
	43.378*
	
	0.489
	1881.68*

	
	
	a
	100.363
	77.324*
	
	
	


注：*表示significant < 0.001

2）生物量反演结果
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图 2 地面实测风干重生物量的频度分布（a）和基于遥感估算的2001-2010年草地生物量干重均值的空间分布（b）
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图3 2001-2010年青藏高原草地地上生物量干重年际变化动态
二、课堂总结
1、该研究的思路和技术流程

2、该研究中涉及到的具体技术和操作步骤

三、作业

以书面的形式归纳总结该研究的技术路线，列举3项该研究涉及到的GIS技术及操作步骤。
第八次实验课讲义

实验内容：草业信息数据库设计和实现（4学时）

一、回顾数据库基础知识
数据库（Database，DB）是一个按数据结构来存储和管理数据的计算机软件系统。一方面，数据库是一个实体，它是能够合理保管数据的“仓库”；另一方面，数据库是数据管理的新方法和技术。

数据库中的数据具有数据整体性和共享性。
归纳地说：数据库是按一定结构组织并长期存储在计算机内部的、可共享的大量数据的有机集合。

数据库管理系统(Database Management System, DBMS)是数据库和用户之间的一个接口，包括：数据定义，数据操作，数据库建立、维护、运行和管理等功能。
关系型数据库 Relational Database

Excel、Access、MySQL、Informix、Sybase、Foxpro、SQL Server、Oracle

空间数据库 Spatial Database

Geodatabase、ArcSDE
二、以Excel为例，介绍简单数据库构建原则——范式

1、第一范式：如果关系模式R，其所有的属性均为简单属性，即每个属性都是不可再分的，则称R属于第一范式（First Normal Form，1NF）记作：R∈1NF。

第一范式是关系型数据必须满足的最低要求。
2、第二范式: 若R∈1NF，且每个非主属性完全依赖于码。第二范式（2NF）要求数据库表中的每个实例或记录必须可以被唯一地区分。
举例：

假设有这样一张表：

属性集={学号，姓名，年龄，班级，班主任，课程名称，成绩}

这张表，由于同一个学生可能有多门课程和成绩，所以这张表不满足第二范式。如果做如下分解，则满足第二范式。

学生={学号, 姓名, 年龄, 班级, 班主任}

课程={学号, 课程名称, 成绩}

3、第三范式：在2NF基础上，每一个非主属性既不部分函数依赖于码，也不传递函数依赖于码。
举例：
考察学生={学号,姓名,年龄,班级,班主任}

学号确定班级，班级确定班主任，所以存在主属性学号和班主任之间的传递依赖，不满足3NF，如下分解则满足：

学生 ={学号,姓名,年龄,班级}

班级={班级,班主任}
三、以ACCESS为例，介绍SQL语言

SQL（Structured Query Language）于1974年由Boyce和Chamberlin 提出。1975-1979年IBM公司实现该语言。

SQL是一种介于关系代数与关系演算之间的结构化查询语言。
1、查询

SELECT <目标列组>

     FROM <数据源>

      [WHERE <选择条件>]

      [GROUP BY <分列组> [HAVING<组选择条件>]]

      [ORDER BY <排序列><排序要求1> [,…n]];

举例：

学生 ={学号,姓名,年龄,班级}

select 学号,姓名 from 学生

select姓名,年龄,班级 from 学生  where 学号 = 2002001

select * from 学生

select count(*) from 学生
2、插入

INSERT  INTO

    <表名>[(<属性列1>[,<属性列2>…)]

    VALUES (<常量1>[,<常量2>]…);
举例：

学生 ={学号,姓名,年龄,班级}

insert into 学生(学号,姓名,年龄,班级)

    Values(2002001,’张三’,18,’一班’)
3、修改

UPDATA <表名>

      SET <列名> = <表达式>[,<列名> = <表达式>][,…n]

      [WHERE <条件>];
举例：

学生 ={学号,姓名,年龄,班级}

updata 学生

      set 年龄 = 19,班级 = ’二班’ 

      where 学号 = 2002001
4、删除

DELETE

        FROM <表名>

           [WHERE <条件>];
举例：

学生 ={学号,姓名,年龄,班级}

delete from 学生 where 学号 = 2002001
四、课堂总结

1、数据库建立的基本流程
2、EXCEL、ACCESS和大型数据库，如SQL Server的联系和差异
五、作业

以书面的形式归纳总结范式的重要性。
第九次实验课讲义

实验内容：空间分析建模综合分析（4学时）
一、ArcGIS空间建模
空间分析模型是指用于GIS空间分析的数学模型，空间分析建模是指运用GIS空间分析建立数学模型的过程，其过程包括明确问题、分析问题，组建模型、检验模型结果和应用分析结果。
模型是对现实世界中的实体或现象的抽象或简化，是对实体或现象中的最重要的构成及其相互关系的表述。空间分析是地理信息系统的主要特征，也是评价一个地理信息系统功能的主要指标之一。它是基于地理对象的位置和形态特征的数据分析技术，其目的在于提取和传输空间信息。空间分析模型是对现实世界科学体系问题抽象的空间概念模型，与广义的模型既有联系，又有区别。
1、图解建模

图解建模是指用直观的图形语言将一个具体的过程模型表达出来。在这个模型中分别定义不同的图形代表输入数据、输出数据、空间处理工具，它们以流程图的形式进行组合并且可以执行空间分析操作功能。当空间处理涉及到许多步骤时，建立模型可以让用户创建和管理自己的工作流，明确其空间处理任务，为复杂的GIS任务建立一个固定有序的处理过程。
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模型生成器（Model Builder）是ARCGIS9提供的构造地理处理工作流和脚本的图形化建模工具，可简化复杂地理处理，模型的设计和实施。
模型生成器的启动

在ArcGIS9中可以通过以下方式启动模型生成器：

1）打开ArcMap或Arccatalog，启动ArcToolbox。

2）右键单击ArcToolbox，选择Newtoolbox命令，生成Toolbox。

3）右键单击Toolbox，在New中选择Model命令，生成Model。

另外，在ArcGIS9.3中的工具条上增加了Model图标，可以直接点击生成Model。

二、Python简介
Python 是一种不受局限、跨平台的开源编程语言，它功能强大且简单易学。因而得到了广泛应用和支持。要了解有关 Python 的详细信息，请访问 http://www.python.org/
ESRI 已将 Python 完全纳入 ArcGIS 中，并将其视为可满足我们用户社区需求的语言。下面仅介绍 Python 的部分优势：

易于学习，非常适合初学者，也特别适合专家使用

可伸缩程度高，适于大型项目或小型的一次性程序（称为脚本）

可移植，跨平台

可嵌入（使 ArcGIS 可脚本化）

稳定成熟

用户社区规模大
三、课堂总结

1、空间建模与ArcGIS的关系

2、空间建模在数据处理中的作用

四、作业

建立简单模型，实现依据DEM自动化提取坡度、坡向数据。
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